
 This certifies that the table below lists the Certificate Programs and students enrolled and completed

Sr. No Name of Add on/ Certificate Programs offered Number of

students 

enrolled in

the year

Number of student

completing the course

in the year 

1 Certificate Course in Introduction to Indian constitution 30 30

1 Certificate Course in Indroductory Skills for R & D Chemist 30 30

2 Certificate Course in English Communication and Employability

Skills 

30 30

3 Certificate Course in Yoga & Naturapathy 30 30

1.2.1 Number of Add on/Certificate Programs offered during the last five Years 

Year 2018-19

Year 2019-20



4 Certificate Course in Introduction to Indian constitution 30 30

1 Certificate Course in Bio Fertilizers 30 30

2 Certificate Course in Indroductory Skills for R & D Chemist 38 32

3 Certificate Course in Intoduction of Basic Computer Tools 30 30

4 Certificate Course in Goat Farming 30 30

1 Certificate Course in Bio Fertilizer 30 30

2 Certificate Course in Indroductory Skills for R & D Chemist 45 43

3 Certificate Course in Intoduction of Basic Computer Tools 30 30

4 Certificate Course in Yoga & Naturapathy 30 30

5 Certificate Course in Goat Farming 30 30

1 Certificate Course in Bio Fertilizer 30 30

2 Certificate Course in Indroductory Skills for R & D Chemist 29 21

3 Certificate Course in Intoduction of Basic Computer Tools 30 30

4 Certificate Course in Yoga & Naturapathy 30 30

5 Certificate Course in Goat Farming 30 30

6 Certificate Course in Life Skills Development 20 6

Year 2022-23

Year 2020-21

Year 2021-22
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List of admitted students for Career Oriented Courses under Ordinance 181 

6 

7 

8 

10 

11 
12 
13 
14 

6 

19 
20 

Smt. Godavaribai Ganpatrao Khadse College, 
Muktainagar Tal: Muktainagar, Dist: Jalgaon (MS) 425306 

Dr. H. A. Maha jan (M.Se. Ph. D.) 
Acting Principal 

3) Academic year: 2022-23 
4) Total students : 20 

1) Name of College/Institute : Smt. G. G. Khadse college Muktainagar Dist. Jalgaon 2) Name of Career Oriented Course : Life Skills Development 

NAAC Reacrriditated B+ 

Muktainagar Taluka Education Society's 

Full Name of the students 

Borole Bhagyashri Raman 
Bhilala Dinesh Mahavir 
Bhoi Pratikshya Pundalik 
Borole Nitin Anil 
Bhoi Shital Anil 
Dutte Nikita Atmaram 
Dhake Chetana Devendra 
Giri Shraddha Vikas 
Jaware Sanika Bhika 

Jaykar Bhagyashri Vitthal 
Kavale Achal Rajendra 
Kalaskar Sushama Shantaram 
Patil Dipti Yadav 
Sapkale Kajal Sanjay 
Shelake Dnyaneshwar Santosh 
Tadavi Arbaj Turebaj 
Tadavi Ashpak Inus 
Valaskar Chaitali Sunil 

Vanjari Sapna Ashok 
Wani Neha Ganesh 

tigk 
dse 

Uktainag 

M 

GenderCategory 

M 

F 

M 
M 

klsadsc college1990@rcdillnail.con: 

M 

F 

OBC 
ST 

Date : /10/2022 

N.T-B 
OBC 
N.T-B 
OBC 
OBC 

N.T-B 
OBC 
SC 

N.T-C 
SC 
OBC 
ST 
NT-C 
ST 
ST 

Ph: 02583-234408 

OBC 
NT-D 
OBC 

Presently 
Admitted Class. 

S.Y.B.Com 
T.Y.B.A 
|S.Y.B.Com 
S.Y.B.Com 
T.Y.B.Com 
S.Y.B.Com 

T.Y.B.Com 
S.Y.B.Com 
F.Y.B.Sc 

S.Y.B.Com 
S.Y.B.Com 
T.Y.B.Com 
S.Y.B.Com 
S.Y.B.Com 

T.Y.B.Com 
T.Y.B.A 
T.Y.B.A 
S.Y.B.Com 

T.Y.B.Con1 
|S.Y.B.Com 

PRIHCIPAL 
Smt.G.G. Khedee Sclenee & 

Arts CoHege, Muktalne ger 



MTES Srt G:a khadse coilege mukteinagar 
Louse Narme Life Skill peveloprnet 

. HGTCHF TEU HY ? 

R. u BU Fs ? 

. - yujq u ? 

. 4- Hhyta 3 HiT ? 

4. H6TIHTT HBg H0T ? 
. gHY0T XGILUYrT Hf T. ? 

H0T ? 



Coordinator, 
La SM Devopment Coune, 
TES St, G. G. Khadse College. 

tra.Ta Mutainaq, Dist Jalg C(MTE S 

PYincipal 
Snt Oodawaribai Ganpatrao Khadse 
Collene Mtainapar, Dist. lalqaon (M S 



MTES Srt G:a khadse coilege mukteinagar 
Louse Narme Life Skill peveloprnet 

. HGTCHF TEU HY ? 

R. u BU Fs ? 

. - yujq u ? 

. 4- Hhyta 3 HiT ? 

4. H6TIHTT HBg H0T ? 
. gHY0T XGILUYrT Hf T. ? 

H0T ? 



Coordinator, 
La SM Devopment Coune, 
TES St, G. G. Khadse College. 

tra.Ta Mutainaq, Dist Jalg C(MTE S 

PYincipal 
Snt Oodawaribai Ganpatrao Khadse 
Collene Mtainapar, Dist. lalqaon (M S 



Muktainagar Taluka Education Society's 

Smt. Godavaribai Ganpatrao Khadse College, irefi jraTAÝTAÉ JrujqrRT� s0 HETfTtY, 
Muktainagar, Dist: Jalgaon-425306 

Visit @ www.khadsecollege.in 
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Nanne of Coliege : Smt. G. G. Khdse College Muktainagar 
Course Name (Full) : Life Skill Development 
Academic Year: 2022-23 
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Ful Name of The Student 

(Surname First) 
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Borole Bhagyashri Raman 
Jayakar Bhagyashri Vthal 
Patil Dipti Yadav 

Tadavi Ashpak Inus 
Valaskar Chaitali Sunil 

Wani Neha Ganesh 

3 

Table - I 
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NAAC Reacrriditated B+ 

Muktainagar Taluka Education Society’s 

Smt. Godavaribai Ganpatrao Khadse College,       
  Muktainagar Tal: Muktainagar, Dist: Jalgaon (MS) 425306 

Dr. H. A. Mahajan  (M.Sc. Ph. D.)                                  Ph: 02583-234408 
       Acting Principal                                               khadse_college1990@rediffmail.com 
                                   

 

09.08.2022 

Department of Computer Science 

NOTICE 

 All S.Y.B.Sc. Computer Science students are hereby informed that, our Computer 

Science department has started a new certificate course entitled “Introduction to Basic 

Computer Tools”. This Course is beneficial to develop their presentation skills for future. 

Students those who are interested for above certificate course can take their admission from 

10/08/2022 to 31/08/2022. The intake capacity for this course is 30 students only. The course 

will start from 01/09/2022 onwards. 

For the admission Contact: Dr. Ranjana S. Zinjore 9960931599 

                                                                                     

                         Head  

       Department of Computer Science  

               Mrs. Seema V. Rane  
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NAAC Reacrriditated B+ 

Muktainagar Taluka Education Society’s 

Smt. Godavaribai Ganpatrao Khadse College,       
  Muktainagar Tal: Muktainagar, Dist: Jalgaon (MS) 425306 

Dr. H. A. Mahajan  (M.Sc. Ph. D.)                                  Ph: 02583-234408 
       Acting Principal                                               khadse_college1990@rediffmail.com 
                                   

 
 Certificate Course on Introduction to Basic Computer Tools 

Admitted Student List 2022-2023 

 

Sr.  

No. Name of Student Gender 

Mobile 

No. Email 

1 Badhe Prajwal Rajendra Male 7387550483 prajwalbadhe12@gmail.com 

2 Badhe Pranav Sharad Male 7620795375 pranavbadhe20@gmail.com 

3 Bhople Aditya Anant Male 7448078040 aadityabhople3@gmail.com 

4 Borole Kajal Manohar Female 7249769259 kajalborole2003@gmail.com 

5 Chaudhari Chaitali Sandip Female 7875489265 sandipchaudhari0674@gmail.com 

6 Chaudhari Megha Shrikrushna Female 8263962733 meghachaudhri9@gmail.com 

7 Chaudhari Sakshi Sanjay Female 7083329473 sakshischaudhari003@gmail.com 

8 Chaudhari Shraddha Vijay Female 9765831505 svchaudhari@gmail.com 

9 Chaudhari Swastik Vivekanand Male 8888207241 swastikchaudhari2@gmail.com 

10 Chaudhari Vivek Sunil Male 9011934878 chaudharivivek455@gmail.com 

11 Chaudhari Yogesh Satish Male 7888265572 yogeshchaudhari9765@gmail.com 

12 Chavhan Snehal Raju Female 7066553731 snehalc002@gmail.com 

13 Jangale Rita Anil Female 9145568801 ritajangale20@gmail.com 

14 Kapse Aakanksha Gajanan Female 9356870845 akankshakapse92@gmail.com 

15 Kapse Mayuri Vinod Female 7666277973 mayurikapse4@gmail.com 

16 Khodke Komal Shrikrushna Female 8010762895 komalkhodke45@gmail.com 

17 Naphade Rohini Dilip Female 9307709317 naphaderohini2003@gmail.com 

18 Patil Arpita Eknath Female 8888916247 patilarpita235@gmail.com 

19 Patil Ashwini Kamalakar Female 7276091685 ashwinipatil9158@gmail.com 

20 Patil Devyani Pramod Female 8080825105 Patildevyani612@gmail.com 

21 Patil Komal Subhash Female 8698344211 kp844641@gmail.com 

22 Patil Lalita Santosh Female 9322041139 linapatil261@gmail.com 

23 Patil Pragati Sanjay Female 7498099626 pragati0325372@gmail.com 

24 Prajapati Nikita Ishwar Female 7030239281 Prajapatinikita050@gmail.com 

25 Rajput Pritee Pradip Female 8080153417 rajputpritee416@gmail.com 

26 Rane Sayali Nitin Female 9322059232 ranesayali2603@gmail.com 

27 Sutar Narendra Kadu Male 7709005432 narendrasutar6124@gmail.com 

28 Tandulakar Vaishnavi Ramchandra Female 9022955066 buntytandulakar73@gmail.com 

29 Thokale Nikita Dipak Female 9403481928 thokalenikita6@gmail.com 

30 Wadile Gayatri Lahu Female 9322679450 gayatriwadile524@gmail.com 
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NAAC Reacrriditated B+ 

Muktainagar Taluka Education Society’s 

Smt. Godavaribai Ganpatrao Khadse College,       
  Muktainagar Tal: Muktainagar, Dist: Jalgaon (MS) 425306 

Dr. H. A. Mahajan  (M.Sc. Ph. D.)                                  Ph: 02583-234408 
       Acting Principal                                               khadse_college1990@rediffmail.com 
                                   

 

External Theory Examination Computer Certificate 

Course Work on 

Introduction to Basic Computer Tools 

2022-23 

Time: 2 Hours                                                                                          Marks: 60M 

 

Note: Attempt any 6 questions. Each question carries 10M. 

1) Enlist any three features of word and also write its applications? 

2) Write advantages of Excel? Write down the steps to create line chart? 

3) Why power point is important? How to apply animation to slide? 

4) What is a pivot table? Write down the steps to create a simple pivot table in Excel? 

5) Explain any three web browser in detail? 

6) What is Internet? Write any three application of Internet? 

7) How to use different formulas in excel? Explain with example? 

8) Write down the steps of using N-List? 
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Muktainagar Taluka Education Society’s 

Smt. Godavaribai Ganpatrao Khadse College,       
  Muktainagar Tal: Muktainagar, Dist: Jalgaon (MS) 425306 

Dr. H. A. Mahajan  (M.Sc. Ph. D.)                                  Ph: 02583-234408 
       Acting Principal                                               khadse_college1990@rediffmail.com 
                                   

 
 Certificate Course on Introduction to Basic Computer Tools 

Admitted Student Result 2022-2023 

 

Roll NO StudentFullName P1 p2 Total percentage  Grade  

1 Badhe Prajwal Rajendra 70 75 145 72.5 A 

2 Badhe Pranav Sharad 76 77 153 76.5 A 

3 Bhople Aditya Anant 56 77 133 66.5 B 

4 Borole Kajal Manohar 60 67 127 63.5 B 

5 Chaudhari Chaitali Sandip 62 66 128 64 B 

6 Chaudhari Megha Shrikrushna 67 78 145 72.5 A 

7 Chaudhari Sakshi Sanjay 70 75 145 72.5 A 

8 Chaudhari Shraddha Vijay 68 70 138 69 B 

9 Chaudhari Swastik Vivekanand 62 76 138 69 B 

10 Chaudhari Vivek Sunil 78 80 158 79 A 

11 Chaudhari Yogesh Satish 70 72 142 71 A 

12 Chavhan Snehal Raju 68 70 138 69 B 

13 Jangale Rita Anil 78 80 158 79 A 

14 Kapse Aakanksha Gajanan 60 60 120 60 B 

15 Kapse Mayuri Vinod 62 60 122 61 B 

16 Khodke Komal Shrikrushna 56 60 116 58 C 

17 Naphade Rohini Dilip 58 67 125 62.5 B 

18 Patil Arpita Eknath 80 88 168 84 O 

19 Patil Ashwini Kamalakar 70 76 146 73 A 

20 Patil Devyani Pramod 60 70 130 65 B 

21 Patil Komal Subhash 68 80 148 74 A 

22 Patil Lalita Santosh 60 65 125 62.5 B 

23 Patil Pragati Sanjay 62 70 132 66 B 

24 Prajapati Nikita Ishwar 70 72 142 71 A 

25 Rajput Pritee Pradip 70 78 148 74 A 

26 Rane Sayali Nitin 60 60 120 60 B 

27 Sutar Narendra Kadu 78 80 158 79 A 

28 Tandulakar Vaishnavi Ramchandra 60 62 122 61 B 

29 Thokale Nikita Dipak 56 60 116 58 C 

30 Wadile Gayatri Lahu 60 64 124 62 B 
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Smt. G. G. Khadse College, Muktainagar 

Department of Computer Science  
NAAC Re-Accredited “B+ Grade” 

Tal. Muktainagar, Dist. Jalgaon- 425306 (Maharashtra) 

Affiliated to KBC North Maharashtra University, Jalgaon 

 This is to certify that, , has successfully completed 

the certificate course in “Introduction to Basic Computer Tools” and passed with grade 

 organized by Department of Computer Science, MTES’s Smt. G. G. Khadse College, 

Muktainagar, Dist- Jalgaon (M.H.) in academic year 2022-23. 

Coordinator                              Head of Department                    Principal 

Dr. Ranjana S. Zinjore                   Mrs. Seema V. Rane   Dr. Hemant A. Mahajan 

Muktainagar Taluka Education Society's 

CERTIFICATE 

Borole Kajal Manohar

B



  
Smt. G. G. Khadse College, Muktainagar 

Department of Computer Science  
NAAC Re-Accredited “B+ Grade” 

Tal. Muktainagar, Dist. Jalgaon- 425306 (Maharashtra) 

Affiliated to KBC North Maharashtra University, Jalgaon 

 This is to certify that, Mr. Badhe Prajwal Rajendra, has successfully completed 

the certificate course in “Introduction to Basic Computer Tools” and passed with grade 

A organized by Department of Computer Science, MTES’s Smt. G. G. Khadse College, 

Muktainagar, Dist- Jalgaon (M.H.) in academic year 2022-23. 

Coordinator                              Head of Department                    Principal 

Dr. Ranjana S. Zinjore                   Mrs. Seema V. Rane   Dr. Hemant A. Mahajan 

Muktainagar Taluka Education Society's 

CERTIFICATE 
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NAAC Reacrriditated B+ 

Muktainagar Taluka Education Society’s 

Smt. Godavaribai Ganpatrao Khadse College,       
  Muktainagar Tal: Muktainagar, Dist: Jalgaon (MS) 425306 

Dr. H. A. Mahajan  (M.Sc. Ph. D.)                                  Ph: 02583-234408 
       Acting Principal                                               khadse_college1990@rediffmail.com 
                                   

 

10.08.2021 

Department of Computer Science  

                NOTICE                                        

 

 All S.Y.B.Sc. Computer Science students are hereby informed that, our 

Computer Science department has started a new certificate course entitled 

“Introduction to Basic Computer Tools”. This Course is beneficial to develop 

their presentation skills for future. Students those who are interested for above 

certificate course can take their admission from 11/08/2021 to 30/08/2021. The 

intake capacity for this course is 30 students only. The course will start from 

01/09/2021 onwards.  

For the admission Contact:  Dr. Ranjana S. Zinjore 9960931599 

 

 

       Head of Department 

          Mrs.Vandana V. Chaudhari 

 

 

 

 

 Course Coordinator
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MTES’s Smt. G. G. Khadse College, Muktainagar  
 

 

Syllabus for Certificate Course  

 

in 

 Introduction to Basic Computer Tools 

 

 

 

Title of Paper: Know Your Desktop- MS-Office  

Total Credits for the paper : 4 (2 Theory + 2 Practical) 

Total Marks for the paper :200 [External : 60, Internal : 40] 

Course Duration: 6 Months (September to February) 

 

Paper Structure 

 

Paper Title Credits Hours/Week 

(Clock Hours) 

Marks (Total 

200) 

Know Your 

Desktop- MS-

Office 

2 Theory 30 Lectures 100 [External : 

60, Internal : 40] 

2 Practical (2 

hours)  

15 Lectures  100 [External : 

60, Internal : 40] 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 



  

 

MTES’s Smt. G. G. Khadse College, Muktainagar  
 

 

SYLLABUS FOR CERTIFICATE COURSE  

in 

 Introduction to Basic Computer Tools (IBCT) 

 

Paper Title: Know Your Desktop- MS-Office (Theory) 

 
Course Outcomes:  

1. To prepare various documents according to need with the help of MS-Word. 

2. For preparing any type of graph with the data and calculations which is required for 

project to show in presentation, also get ideas for the preparation of presentation 

slides and Research posters. 

3. To aware about various search engines and to browse data in a smart way including 

advanced search. 

 

Unit 1: Introduction to MS-Office & MS-Word [L: 08; M:25] 
1.1 Introduction, Background, Introduction to MS-Word 

1.2 Features of Word,  

1.3 Study of  menus, commands, Toolbars, Formatting 

1.4 Editing Documents  

1.5 Tables, page setup, Drawing Tools, Hyperlink 

 

Unit 2: Introduction to MS-Excel [L:08; M:25] 
2.1 Introduction to MS-Excel 

2.2 Features of Excel 

2.3 Study of menus, commands, Toolbars,  

2.4 Working with Function,  

2.5 Entering formulas 

2.6 chart, Pivot Table, Power Query 

 

Unit 3: Introduction to MS-PowerPoint [L:07; M:25] 
3.1 Introduction to MS-PowerPoint 

3.2 Features of PowerPoint, 

3.3 starting MS –PowerPoint 

3.4 Study of  menus, commands, Toolbars 

3.5 Entering slides, how  to prepare slides, opening , saving presentation,  

3.6 Animation Effects 

 

 



  

 

Unit 4: Internet Fundamental [L:07; M:25] 
4.1 Use of Internet 

4.2 Study of Web Browsers 

4.3 Brower updation,   

4.4 Search Engines 

4.5 Advanced Search option                                                     

4.6 How to use N-list. 
 

References 

1) V. Rajaraman, “Fundamentals of Computers”, PHI publication, ISBN: 8120340116, 

9788120340114 

2) C.S.Changeriya, “Basic Computer Course Paperback”  Chetan Publication; 2010th 

edition (1 January 2010), ISBN: 978-9386953131. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 



  

 

Paper Title: Know Your Desktop- MS-Office (Practical) 
 

Practical List 

1) Demonstrate use of text formatting and tables in word. 

2) Demonstrate use of shapes and Hyperlink in word. 

3) Demonstrate use of page setup and in word. 

4) Create a chart in excel showing marks of different subject of 5 students. 

5) Create a power point presentation (10 slides) with animated effect 

6) Create a spreadsheet which will demonstrate use of aggregate functions 

7) Login through your E-Mail ID and do the following:    

 Send the Mail to one person 

 Delete the Mail 

 Send file as attachment 

8) Use internet explorer as a web browser for uploading subject related video and text 

information. 

9) Study different web browser and prepare the comparative study. 

10) Give working of search engine. 
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Note: Attempt any 30 questions. 

 

1. In which view Headers and Footers are visible 

A.Normal View 

B.Page Layout View 

C.Print Layout View 

D.Draft View 

 

2.The process of removing unwanted part of an image is called 

A.Hiding 

B.Bordering 

C.Cropping 

D.Cutting 

 

3.To apply center alignment to a paragraph we can press 

A.Ctrl + S 

B.Ctrl + C 

C.Ctrl + C + A 

D.Ctrl + E 

 

4. Text-styling feature of MS word is 

A.WordColor 

B.WordFont 

C.WordArt 

D.WordFill 

 

 

5.The space left between the margin and the start of a paragraph is called 

A.Spacing 

B.Gutter 

C.Indentation 

D.Alignment 

 

6.Which of the following is MS Office Suite's software program? 

A. Microsoft Word 

B. Microsoft Excel 
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C. Microsoft PowerPoint 

D. All of the above 

 

7. Microsoft Word is a ____. 

A. Computer Hardware Program 

B. Computer Non-application Program 

C. Computer Application Program 

D. None of the above 

 

8.What is MS Word used for? 

A. Design Pictures 

B. Design Videos 

C. Paint 

D. Design Texts 

 

9.Documents can be ____ with MS Word. 

A. Created 

B. Edited 

C. Saved 

D. All of the above 

 

10.Which is not in MS Word? 

(A) Italic 

(B) Font 

(C) Bold 

(D) Magic tool 

 

11.What is landscape? 

(A) Page Orientation 

(B) Paper Size 

(C) A Font Style 

(D) Page Layout 

 

12. Which function key is used to spell check? 

(A) F6 

(B) F7 

(C) F8 

(D) F5 

 

13.Numbers or letters that appear below the normal text are called? 

(A) Subscript 

(B) Toptext 

(C) Supertext 

(D) Superscript 
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14.Which feature of Microsoft Word helps in creating list? 

(A) Bullets and Numbering 

(B) Word Wrap 

(C) Scaling 

(D) Word Art 

 

15.What is the default file extension for all MS Word documents? 

(A) .word 

(B) .txts 

(C) .docx 

(D) .docs 

 

16.What shortcut key is used to split a table in MS Word? 

(A) Ctrl + Shift + Enter 

(B) Alt + Space + Enter 

(C) Ctrl + Alt + Enter 

(D) Alt + Shift + Enter 

 

17.You can change vertical alignment from? 

(A) Page Setup dialog box 

(B) Formatting toolbar 

(C) Standard toolbar 

(D) Paragraph dialog box 

 

18. Which can be used for quick access to commonly used commands and tools? 

A. Status bar 

B. Tool bar 

C. Menu bar 

D. Title bar 

 

19.If you need to change the typeface of a document, which menu will you choose? 

A. Edit 

B. View 

C. Format 

D. Tools 

 

20.To auto fit the width of column 

A. Double click the left border of column 

B. Double click the right border of column 

C. Double click the column header 

D. All of above 
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21. Excel is a ____ program developed by Microsoft. 

A. Spreadsheet 

B. Document 

C. Data management 

D. All of the above 

 

22. What is the extension of a Microsoft Excel file? 

A. msxcl 

B. xcl 

C. xlsx 

D. xlsm 

 

23. Microsoft Excel is used for? 

A. Analysis 

B. Data Entry 

C. Data Management 

D. Accounting 

E. Budgeting 

F. All of the above 

 

24. What is the short cut key to highlight the entire column? 

A. Ctrl + C 

B. Ctrl + Enter 

C. Ctrl + Page Up 

D. Ctrl + Space Bar 

 

25. How do you display current date only in MS Excel? 

A. Date () 

B. Today () 

C. Now () 

D. Time () 

 

26. Which area in an Excel window allows entering values and formulas? 

A. Title Bar 

B. Menu Bar 

C. Formula Bar 

D. Standard Tool Bar 

 

27. An Excel Workbook is a collection of ________ 

A. Workbooks 

B. Worksheets 

C. Charts 

D. Worksheets and Charts 
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28. MS-EXCEL is based on ________ 

A. WINDOWS 

B. DOS 

C. UNIX 

D. OS/2 

 

29. What is the shortcut key to replace a data with another in sheet? 

A. Ctrl + R 

B. Ctrl + Shift + R 

C. Ctrl + H 

D. Ctrl + F 

 

30. To select an entire column in MS-EXCEL, press? 

A. CTRL + C 

B. CTRL + Arrow key 

C. CTRL + S 

D. None of the above 

 

31. Which is not the function of “Edit, Clear” command? 

A. Delete contents 

B. Delete notes 

C. Delete cells 

D. Delete formats 

 

32. Which of the following is not a valid data type in Excel? 

A. Number 

B. Character 

C. Label 

D. Date/Time 

 

33. How do you rearrange the data in ascending or descending order? 

A. Data Sort 

B. Data Form 

C. Data Table 

D. Data Subtotals 

 

34. Which Chart can be created in Excel? 

A. Area 

B. Line 

C. Pie 

D. All of the above 

 

35. Which language is used to create macros in Excel? 

A. Visual Basic 
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B. C 

C. Visual C++ 

D. Java 

 

36. Which key do you press to check spelling? 

A. F3 

B. F5 

C. F7 

D. F9 

 

37. Multiple calculations can be made in a single formula using ________ 

A. Standard Formulas 

B. Array Formula 

C. Complex Formulas 

D. Smart Formula 

 

38. Comments can be added to cells using ________ 

A. Home > Comments 

B. Insert > Comment 

C. Data > Comments 

D. View > Comments 

 

39. Which of the following is not a valid data type in Excel? 

A. Number 

B. Character 

C. Label 

D. Date/Time 

 

40. The first cell in EXCEL worksheet is labeled as 

A. AA 

B. A1 

C. Aa 

D. A0 
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Certificate Course on Introduction to Basic Computer Tools 

 

Admitted Student List 2021-2022 Result  

 

Roll NO StudentFullName P1 p2 Total percentage  Grade  

1 BADOGE PIYUSH DILIP 90 92 182 91 O 

2 BARHATE NIKITA ANIL 86 88 174 87 O 

3 BARHATE RAHUL EKNATH 92 94 186 93 O 
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5 CHAUDHARI KOMAL MADHUKAR 70 70 140 70 A 
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7 FEGADE POOJA PURUSHOTTAM 68 78 146 73 A 

8 JAIN ROSHANI ANIL 76 80 156 78 A 
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JANGALE VAISHNAVI 

PRABHAKAR 80 84 164 82 O 

10 KHARCHE KANCHAN SADANAND 78 80 158 79 A 

11 LOKHANDE SHRUTI PRAVIN 60 70 130 65 B 

12 MORE MAMATA PRAMOD 58 60 118 59 C 

13 NAPHADE PRANJALI PRAVIN 60 60 120 60 B 

14 NARWADE ADESH RAMESH 70 82 152 76 A 

15 NAYASE VAISHNAVI SURESH 88 94 182 91 O 

16 PACHPANDE  SAKSHI RAJENDRA 74 80 154 77 A 

17 PATIL  BHAGYASHRI SANJAY 60 65 125 62.5 B 

18 PATIL APEKSHA VILAS 75 78 153 76.5 A 

19 PATIL CHAITALI RAVINDRA 60 64 124 62 B 

20 PATIL GAYATRI HARI 68 70 138 69 B 

21 PATIL KAJAL PRAVIN 84 90 174 87 O 

22 PATIL KOMAL RAJENDRA 58 60 118 59 C 

23 PATIL NILAM HEMANT 68 70 138 69 B 

24 PATIL RESHMA SUNIL 68 76 144 72 A 

25 PATIL SHUBHAM SURESH 60 68 128 64 B 

26 PATIL TUSHAR SUNIL 74 78 152 76 A 

27 PATIL VIKIATA AJABRAO 80 88 168 84 O 

28 ROZATKAR VAISHNAVI  MOHAN  60 68 128 64 B 

29 TALELE SHREYASH GIRISH 90 90 180 90 O 

30 VARADE NIKITA SUNIL 76 82 158 79 A 
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                                                                                                    Date: 14.08.2020 

Department of Computer Science 

  NOTICE        

All S.Y.B.Sc. Computer Science students are hereby informed that, our 

Computer Science department has started a new certificate course entitled 

“Introduction to Basic Computer Tools”. This Course is beneficial to develop 

their presentation skills for future. Students those who are interested for above 

certificate course can take their admission from 16/08/2020 to 31/08/2020. The 

intake capacity for this course is 30 students only. The course will start from 

01/09/2020 onwards. 

For the admission Contact: Dr. Ranjana S. Zinjore 9960931599 
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OBC (इतर मागास 

वगग) 
Fem
ale 

9199239
32991 

pranitavarade2002@gmail
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OBC (इतर मागास 

वगग) 
Male 

8766541
833 

gauravpachpande2001@gmai
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Syllabus for Certificate Course  

 

in 

 Introduction to Basic Computer Tools 

 

 

 

Title of Paper: Know Your Desktop- MS-Office  

Total Credits for the paper : 4 (2 Theory + 2 Practical) 

Total Marks for the paper :200 [External : 60, Internal : 40] 

Course Duration: 6 Months (September to February) 

 

Paper Structure 

 

Paper Title Credits Hours/Week 

(Clock Hours) 

Marks (Total 

200) 

Know Your 

Desktop- MS-

Office 

2 Theory 30 Lectures 100 [External : 

60, Internal : 40] 

2 Practical (2 

hours)  

15 Lectures  100 [External : 

60, Internal : 40] 
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MTES’s Smt. G. G. Khadse College, Muktainagar  
 

 

SYLLABUS FOR CERTIFICATE COURSE  

in 

 Introduction to Basic Computer Tools (IBCT) 

 

Paper Title: Know Your Desktop- MS-Office (Theory) 

 
Course Outcomes:  

1. To prepare various documents according to need with the help of MS-Word. 

2. For preparing any type of graph with the data and calculations which is required for 

project to show in presentation, also get ideas for the preparation of presentation 

slides and Research posters. 

3. To aware about various search engines and to browse data in a smart way including 

advanced search. 

 

Unit 1: Introduction to MS-Office & MS-Word [L: 08; M:25] 
1.1 Introduction, Background, Introduction to MS-Word 

1.2 Features of Word,  

1.3 Study of  menus, commands, Toolbars, Formatting 

1.4 Editing Documents  

1.5 Tables, page setup, Drawing Tools, Hyperlink 

 

Unit 2: Introduction to MS-Excel [L:08; M:25] 
2.1 Introduction to MS-Excel 

2.2 Features of Excel 

2.3 Study of menus, commands, Toolbars,  

2.4 Working with Function,  

2.5 Entering formulas 

2.6 chart, Pivot Table, Power Query 

 

Unit 3: Introduction to MS-PowerPoint [L:07; M:25] 
3.1 Introduction to MS-PowerPoint 

3.2 Features of PowerPoint, 

3.3 starting MS –PowerPoint 

3.4 Study of  menus, commands, Toolbars 

3.5 Entering slides, how  to prepare slides, opening , saving presentation,  

3.6 Animation Effects 

 

 



  

 

Unit 4: Internet Fundamental [L:07; M:25] 
4.1 Use of Internet 

4.2 Study of Web Browsers 

4.3 Brower updation,   

4.4 Search Engines 

4.5 Advanced Search option                                                     

4.6 How to use N-list. 
 

References 

1) V. Rajaraman, “Fundamentals of Computers”, PHI publication, ISBN: 8120340116, 

9788120340114 

2) C.S.Changeriya, “Basic Computer Course Paperback”  Chetan Publication; 2010th 

edition (1 January 2010), ISBN: 978-9386953131. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 

 

 

 

 

 

 

 

 

 

 

 



  

 

Paper Title: Know Your Desktop- MS-Office (Practical) 
 

Practical List 

1) Demonstrate use of text formatting and tables in word. 

2) Demonstrate use of shapes and Hyperlink in word. 

3) Demonstrate use of page setup and in word. 

4) Create a chart in excel showing marks of different subject of 5 students. 

5) Create a power point presentation (10 slides) with animated effect 

6) Create a spreadsheet which will demonstrate use of aggregate functions 

7) Login through your E-Mail ID and do the following:    

 Send the Mail to one person 

 Delete the Mail 

 Send file as attachment 

8) Use internet explorer as a web browser for uploading subject related video and text 

information. 

9) Study different web browser and prepare the comparative study. 

10) Give working of search engine. 

 

 

 



 

MTES’s Smt. G. G. Khadse College, Muktainagar 

External Theory Examination Computer Certificate  

Course Work on  

Introduction to Basic Computer Tools  

2020-21 

Date:                                             Time: 2 Hours                                                  

Note: Attempt any 30 questions. 

 

1)_____ is a presentation program. 

(A) U-torrent 

(B) Mozilla Firefox 

(C) MS PowerPoint 

(D) Slide Pane 

  

2)In PowerPoint, the header and footer button can be found on the insert tab in what group? 

(A) Tables group 

(B) Text group 

(C) Object group 

(D) Illustrations group 

  

3)Which is not the valid edition of MS PowerPoint? 

(A) MS PowerPoint 2003 

(B) MS PowerPoint 2007 

(C) MS PowerPoint 2010 

(D) MS PowerPoint 1920 

 

4)The slide that is used to introduce a topic and set the tone for the presentation is called the 

(A) Title slide 

(B) Bullet slide 

(C) Table slide 

(D) Graph slide 

 

5) Which of the following is the file extension of the PowerPoint application? 

a. .ppt 

b. .jpg 

c. .html 

d. .docs 

 

6) Which of the following is called as page to create a presentation in PowerPoint? 

a. Sheet 

b. Slide 
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c. Paper 

d. None of the above 

 

 

7) Which of the following shortcut key is used to start the slideshow? 

a. Using F5 key 

b. Using F3 key 

c. Using F1 key 

d. Using F6 key 

 

8) The maximum percentage of zoom in PowerPoint is - 

a. 400% 

b. 200% 

c. 350% 

d. 100% 

 

9) Which of the following is the default standard layout in PowerPoint? 

  a.Blank slide 

  b.Title and content slide 

  c.Title slide 

  d.None of the above 

 

10) Which of the following can be implemented using animation? 

a) Fireworks 

b) Fade Effect 

c) Roll-in or Roll-out 

d) All of the mentioned 

 

11). Which is the function that calls another function after a time interval? 

 a) setTimeout() 

  b) setTime() 

  c) callafter() 

  d) timeSet() 

 

12). How do we get the DOM object in JavaScript? 

 a) getElementbyId() 

 b) getObject() 

 c) getElement() 

 d) getNodeobject()   

 

13). ____________ is basically a form of pictorial presentation. 

a) Photography 

b) Animations 
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c) Drawing 

d) Creativity 

 

14). Multiplane camera was introduced by Walt Disney. 

a) True 

b) False 

 

15). The father of animation? 

a) Walt Disney 

b) J. Stuart Blackton 

c) William Horner 

d) J.A. Ferdinand Plateau 

 

16). He made the first animated film in 1906. 

a) Walt Disney 

b) J. Stuart Blackton 

c) William Horner 

d) J.A. Ferdinand Plateau 

 

17)Is it allowed to make a PDF of the powerpoint presentation? 

a. Yes 

b. No 

c. May be 

d. Can't say 

 

18) Which of the following adds a text box on a slide of the powerpoint presentation? 

a. Insert -> Text Box 

b. Design -> Text Box 

c. Format -> Text Box 

d. None of the above 

 

19) Which of the following is not a type of view in powerpoint? 

a. Slide show 

b. Slide sorter 

c. Normal 

d. None of the above 

 

20) The special effects in a powerpoint presentation used to introduce slides are called as - 

1. Effect 

2. Transitions 

3. Slide animation 

4.Custom animation 
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21) It has become the preferred method of communication for sending, recieving and storing 

electronic messages. 

a) Post 

b) Courier 

c) Fax 

d) E-mail 

 

22) Facebook, Instagram, Linked in, Twitter, flickr etc are the examples of ……………. sites 

a) Commercial 

b) Social networking 

c) government department 

d) Shopping site 

 

23) When you are not online, your status is set to 

a) Out of coverage area 

b) not connected 

c) online 

d) offline 

 

24) In ……………………. image and sounds are then sent through the Internet where users 

not only hear each other but can also have face to face communication 

a) Chatting 

b) Video conferencing 

c) Mailing 

d) Morphing image 

 

25)In which year was the first web browser created? 

A)1992 

B)1991 

C)1990 

D)1995 

 

26) Which of the following is the first web browser? 

a) Nexus 

b) Netscape Navigator 

c) Internet Explorer 

d) Mosaic 

 

27) Who created the first web browser 

a) Tim Berners Lee 

b) Jacobs, Lan 

c) Marc Andeersen 

d) Mozilla foundation 
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28) Which of the following is used to read a HTML page and render it? 

a) Web browser 

b) Web server 

c) Web matrix 

d) Web network 

 

29)  It is the worldwide resource for information. 

(a) Internet                    

 b) Newspaper 

 c) Television  

 d) Radio 

 

30) This is the fast, relevant and largest single catalogues of webpages that is available today. 

(a) Google                           

b) yahoo                           

 c) Rediff                        

 d) Bing 

 

31. In which view Headers and Footers are visible 

A.Normal View 

B.Page Layout View 

C.Print Layout View 

D.Draft View 

 

32.The process of removing unwanted part of an image is called 

A.Hiding 

B.Bordering 

C.Cropping 

D.Cutting 

 

33.To apply center alignment to a paragraph we can press 

A.Ctrl + S 

B.Ctrl + C 

C.Ctrl + C + A 

D.Ctrl + E 

 

34. Text-styling feature of MS word is 

A.WordColor 

B.WordFont 

C.WordArt 

D.WordFill 

 

 

35.The space left between the margin and the start of a paragraph is called 
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A.Spacing 

B.Gutter 

C.Indentation 

D.Alignment 

 

36.Which of the following is MS Office Suite's software program? 

A. Microsoft Word 

B. Microsoft Excel 

C. Microsoft PowerPoint 

D. All of the above 

 

37. Microsoft Word is a ____. 

A. Computer Hardware Program 

B. Computer Non-application Program 

C. Computer Application Program 

D. None of the above 

 

38.What is MS Word used for? 

A. Design Pictures 

B. Design Videos 

C. Paint 

D. Design Texts 

 

39.Documents can be ____ with MS Word. 

A. Created 

B. Edited 

C. Saved 

D. All of the above 

 

40.Which is not in MS Word? 

(A) Italic 

(B) Font 

(C) Bold 

(D) Magic tool 
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1 BARHATE PRITI SUDHIR 80 90 170 85 O 

2 

CHAUDHARI GAYATRI 

SITARAM 76 78 154 77 A 

3 

CHIKHALKAR NILIMA 

SUDHAKAR 78 80 158 79 A 

4 

CHOUDHARY HEMANT 
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5 FEGADE PRAJKTA BALU 74 72 146 73 A 

6 GAJARE DIPALI PRADIP 72 76 148 74 A 

7 

GONGE PRIYANKA 

GAJANAN 70 76 146 73 A 

8 GOSAVI MANJULA DINESH 74 78 152 76 A 

9 INGALE PRANJAL KISHOR 60 64 124 62 B 

10 INGLE ADITYA RAJENDRA 78 80 158 79 A 

11 

INGLE SRUSHTI 

YASHWANT 62 70 132 66 B 

12 JANGALE NIKITA PRAMOD 78 82 160 80 O 

13 

KAKPHALE YOGESH 

MACHCHINDRA 70 80 150 75 A 

14 KARE DIVYA GANESH 80 92 172 86 O 

15 KINGE PRASAD SOPAN 70 74 144 72 A 

16 KOLHE SAURAV VASUDEV 74 80 154 77 A 

17 MAHAJAN SRUSHTI SUJIT 60 65 125 62.5 B 

18 

MALI BHAGYASHALI 

BHASKAR 65 68 133 66.5 B 

19 NEMADE NIKITA SHIVAJI 60 64 124 62 B 

20 

PACHPANDE GAURAV 

DILIP 68 70 138 69 B 

21 PATIL AACHAL EKNATH 84 90 174 87 O 

22 PATIL KOMAL MADHUKAR 58 60 118 59 C 

23 

PATIL MAMATA 

SUDHAKAR 68 70 138 69 B 

24 PATIL PRANJAL GOPAL 68 76 144 72 A 

25 PATIL RUPALI GOPAL 60 68 128 64 B 

26 PATIL SAURABH SHARAD 74 78 152 76 A 

27 

SAVALE SURENDRA 

SANTOSH 80 88 168 84 O 

28 SONAWANE ROHIT BHIKA 60 68 128 64 B 

29 

VARADE PRANITA 

MUKESH 60 70 130 65 B 

30 

ZAMBARE DHANRAJ 

KISAN 76 82 158 79 A 
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Grade Percentage 

O 80-100 
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B 60-69 

C 40-59 

F 00-39 
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